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DECEMBER 11 HOLIDAY LUNCH PARTY
Date: Saturday, December 11
Time: 1:00 PM
Cost: $25.00 (including tax and tip)
Cash only—Please bring exact change
Where: Golden China Restaurant
9018 Venice Blvd. Culver City 90232
RSVP with the number in your party by December 7 to
Leah Clark or Annette Tossounian. Spouses and guests
are welcome. Contact Annette or Leah with questions.
Everyone must have proof of COVID vaccination and
a mask to enter.
We are anxious to celebrate the holidays with LACS
members and their guests. Please watch your email for
updates. There will be no general meeting in December.

Breaking News!
Santa has been
studying his Nice
and Naughty lists.
He has found ALL
LACS members on
the Nice List.
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Merry
Christmas

FROM YOUR PRESIDENT / EDITOR
HAPPY HOLIDAYS

Holiday Lunch Party
Saturday, December 11
We are looking forward to enjoying socializing and good food with LACS members and
their guests at our Holiday Lunch Party.
Please be sure everyone brings their COVID
vaccination card and a mask. We celebrate
all LACS member volunteers who have contributed their time and energy to making 2021
a good year for us. Thanks to all.
Gift Membership
Don't forget that a LACS member may give a
gift membership to someone who has never
been a member. It is only $20.00 for one
year. This may be a helpful idea for your
holiday shopping.
Proofreader Needed
I could use another proofreader for User
Friendly. It is too easy for me to miss
typos, have something missing or misplaced, or some other error. This is usually done from the 23rd to the 26th of each
month. If you want to give it a try, please
email me. I thank you.
The APCUG Website
https://apcug2.org
If you haven't looked at the APCUG website
recently, you should give it a try. Get news
about free up-coming video conferences,
many tips for all computer and smartphone
platforms, and find out what other groups are
doing. See the winners of the Newsletter,
Website and Photography contests.
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Happy
Hanukkah

Condolences
We offer our sincere sympathy
to our member, Elliot Silverstein, at the passing of his wife,
of nearly 65 years, Irma. She
loved the outdoors and music,
and she was active in the
League of Women Voters. LACS members
will remember her as a special person. Our
prayers are with Elliot at this sad time that all
his beautiful memories will sustain him.
Now is the Worst Time To Make
Tech Purchases
A member recommended an article from the
ComputerWorld, November 9 issue by Steven
J. Vaughan-Nichols. Below is a link to it.
Because of supply chain problems, getting
new PCs, smartphones, routers, hubs, or any
electronic devise is harder and more expensive than ever. For now, stick with what
you’ve got or consider used equipment.
https:///www.computerworld.com/
article/3639830/thinking-of-upgradingyourcompany-s-tech-gear-now-snot-thetime.html or tinyurl.com/dm82v3sj
Order of LACS General Meeting
When members ask questions before the
presentation, the speaker, who may be in a
later time zone, is delayed. Every attendee
should have time to ask questions. So this is
a meeting schedule I want to try to follow.
6:30 - 7:00 — Q & A and socializing
7:00 - 7:15 — Introductions and LACS
announcements
7:15 - 8:30 — Presentation and Q & A
8:30 - 9:00 (or when all are finished)
— Forum for questions and comments

December 2021

User Friendly — The Los Angeles Computer Society

GENERAL MEETING REPORT
November 9, 2021
By Leah Clark, LACS President and Editor
Topic: Encription
Speaker: Mark Schulman
Central Florida Computer Society
Mark Schulman talked about three different
ways to use encryption. Encryption is scrambling up data so other people cannot get at it.
When a website starts with https, your data are
encrypted from your browser via the servers to
the recipients. Today, much of our data is on
portable devices that may be lost or stolen.
Encryption can help to keep them secure.
1. Single-File Encryption
If you have a single file that you want to keep
secure or email to someone, you may want to
encrypt it. There are several software programs that can encrypt a single file and apply
a password to the file. Some single-file encryption options are Microsoft Office (built-in), 7-Zip
(free software), and AESCrypt (free software).
Mark demonstrated examples of these.
Open a Microsoft Office file, then go to the
File menu > Info > Protect Document > Encrypt with Password. Pick a good, long password and save the document. Anyone needs
to enter the password to open that document.
To encrypt a file that’s not an MS Office document, Mark showed AESCrypt. After he installed it, he right-clicked on a .pdf file > AES
Encrypt > Enter a Password. A new file is created with a .aes extension. The password will
be needed to open it; the person receiving the
file must also have the AES software.
7-Zip is often used to compress multiple files
into a single encrypted file. Open 7-Zip > select and right-click on the files > Add to Archives >. A file called 2020 7Z is created; it
can be renamed. You can then enter a password and click OK.
Mark warned us to be careful to select a file
name that doesn’t give too much information.
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Be sure to give or send the password to recipients separately from the encrypted file.
2. Encrypted Containers
You can create a disc in which all the files
in it , external drives, laptops, and PCs to
store many encrypted files and to encrypt or
decrypt them as needed automatically.
Mark uses VeraCrypt, which is free, opensource software. You create a VeraCrypt
container; the contents are encrypted with a
password, and it becomes a virtual hard
drive on your system. Mark demonstrated
creating a VeraCrypt container. As files are
dragged into the container, they are encrypted and are decrypted when opened.
There are a few more cool VeraCrypt features. Put a container on a flash drive with
the Traveler Flash Drive, and VeraCrypt
also puts a copy of itself on the flash drive.
Key Files will open a VeraCrypt container
without needing to remember a password.
You put a file on a flash drive that will be
like a key to open an encrypted file.
A Hidden container will hide the fact that
there is any data there at all.
3. Whole-Drive Encryption
VeraCrypt can encrypt your entire hard
drive. Mark uses this on his laptops in case
they should become lost. A password will
be needed to start up the computer. Use a
good password, and this is uncrackable by
any known technology. Don’t lose the password — back up your laptop.
Phones
Modern phones have whole-phone encryption built in. ColorNote, is a note-taking app
that can encrypt any note. Microsoft OneNote includes encryption.
During Q & A, Mark discussed LastPass for
managing your passwords.
LACS members have a link to the recording of
this meeting for more information from this excellent presentation. ❖

•
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SELLING ONLINE, PART 6
By Mark Presky, LACS Director
This column will cover a few miscellaneous
items not discussed in my previous discussions of online selling.
NEVER DELIVER! Someone may be waiting in a dark stairwell or behind a wall to rob
you or worse. In addition, once you have taken the trouble to deliver the item, they will
always take advantage of your now being in
their territory and showing that you are anxious to sell the item or negotiate a lower
price. Legitimate buyers will find a way to
meet with you at your place, the corner of
your street, a shopping center, or better, a
police station to complete the sale. If concerned about meeting with a stranger, ask a
friend or neighbor to be with you when the
buyer arrives. During our Covid-19 crisis,
buyers were willing to stand on the sidewalk
in front of my house to examine items and
pay me over the fence. (I then took the cash
inside and disinfected it with 10% bleach.)
Buyer discourtesy: People often don’t show
up after making an appointment with you.
Provide a meeting address or place only
when they are ready to pick up the item. And
don’t wait around much past the meeting
time if you have an errand to run – meet
when it is convenient for you. Let them know
that you won’t wait long. If living in an apartment, meet in the building lobby or in front of
the building. Have them call or text you when
they arrive. Don’t hand them the item while
they sit in their car. And if the item is an electrical appliance, is there a safe, convenient
place to plug it in to demonstrate that it’s
functioning if they desire to see it working?
I am not a lawyer, and I offer no legal advice.
Still, I have been told that unless one provides a verbal or written warranty, sales of
used items are usually understood to be sold
“as is” – with an exception for eBay. With
eBay, if I believe there is a chance that a
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buyer may not be happy with a sales item
once seen, I list it for “local pickup only.”
Then they can handle the item before closing the sale (and leave positive feedback,
which confirms delivery BEFORE taking the
item). On eBay, occasionally, people have
been known to damage an item, claim that it
was damaged upon receipt, and then force
the seller to pay for return shipping and a
refund.
Good luck! I hope that I’ve covered the basics and that you feel more confident with
trying your hand at online selling. As you’ve
read, it may take some time and effort, but it
can definitely be fun.
Go to https://www.lacspc.org/category/ufindex/ to access the User Friendly indexes to find
parts 1-5 of this series. ❖

HOW TO SAFELY CLEAN YOUR
TV OR MONITOR
By Tim Brookes
How-To Geek.com

Yeti studio/Shutterstock.com

There’s definitely a wrong way to clean your
TV or monitor screen. Mess it up, and you’ll
be looking at scratches, smears, or worse
for a long time. Get it right, and your display
will gleam like the day you bought it.
Before you reach for a duster or cleaning
solution, make sure you read this.
Consult The Manufacturer’s
Instructions
Your TV or monitor manufacturer likely has
its own set of cleaning instructions for your
specific display type. This goes for LG
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OLEDs, Samsung QLEDs, and Dell
touchscreen monitors.
While these manufacturer guides often err on
the side of caution and recommend very little
in the way of cleaning products, you may also
find some specific advice to your particular display and the types of coatings used on it.
Some manufacturers, like Dell, recommend 70
-90% isopropyl alcohol on some products.
Others like LG never recommend even moistening the display. If your display is still under
warranty, you might want to carefully follow
these instructions to avoid any problems if you
have to make a claim later on.
Avoid Harsh Cleaning Chemicals
The most important thing to remember is to
avoid any harsh cleaning chemicals including
glass cleaners like Windex, polishes, and even
isopropyl alcohol, unless you have specific
clearance from the manufacturer that this will
not damage the screen.

Mihael Lenard/Shutterstock.com

Such cleaning products are usually made with
ammonia, alcohol, and they contain other
products and fragrances that could damage
the display. These screens often have protective coatings on them to combat glare and reflections or oleophobic coatings to repel fingerprint oil in the case of touchscreens.
If you’ve already used something like this with
no ill-effect, consider yourself lucky and avoid
using it again in the future. Many displays will
be utterly ruined by applying these household
cleaners, leaving streaks and clouding that
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could render the display worthless.
Air and Microfiber Cloths Are Your
Friends
Canned air is an excellent way of removing
dust from a display surface without causing
any damage. Dust particles, though small,
may scratch sensitive surfaces when pressure is applied. By not touching the display,
you’re minimizing your risk of scratching the
delicate surface. This is especially true of
glass TV and monitors, like those that
use OLED technology.
Falcon Dust-Off
Compressed Gas, 3.5 oz
This can of compressed air
is perfect for safely cleaning
your electronics, and the
can is compact enough to fit
in your computer desk.
Second to canned air is a high-quality microfiber cloth, ideally with deep grooves to
catch all the dust without moving it over the
screen. Use the lightest of touches when
cleaning to avoid undue pressure on the display. You may need to turn to a microfibre
cloth when canned air doesn’t cut it.
Avoid paper-based cleaning products like
tissues or kitchen towels since they contain
many small fibers that can scratch the display. This is good advice in general when
cleaning anything reflective, whether it’s a
shiny plastic gadget or a pair of reading
glasses.
You should take care when cleaning the microfiber cloths too. Avoid putting them in the
wash with any fabric softeners or in the dryer with a dryer sheet since these products
contain oils and waxes that may transfer to
any surfaces you wish to clean. This will
leave unwanted streaks on your display.
Lastly, if your microfiber cloth has a tag,
then be aware that the tag probably isn’t
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made of the same microfiber material and
may cause damage to your display. For
peace of mind, snip off any tags with a pair of
scissors before using the cloth.
Use Distilled Water Where Necessary
When air and dry microfiber cloth don’t cut it,
you may need to turn to distilled water instead. While tap water often cotains particles
and minerals that may scratch your screen,
distilled or “pure” water does not.
Use a pump spray bottle to mist a microfiber
cloth until just damp, then spot-fix any stubborn grime that has adhered itself to your
screen. This will likely only work for dry matter. Oil and other streaky marks will probably
need a different approach.
Be aware that some manufacturers will never
recommend using any moisture near your display. LG is one such display manufacturer
that dissuades customers from doing so.
However, the company does not
acknowledge that a dry microfiber cloth is often insufficient to remove stubborn dirt.
You’ll have to use your intuition at this point.
We’ve used distilled water and a microfiber
cloth to remove dried-on grime from a glasspanel LG OLED with no ill effect since the alternative was a distractingly dirty screen.
Screen Cleaning Products Exist if You
Need Them
Some experts recommend using a small
amount of dishwashing liquid dissolved into
distilled water to remove oily stains with a microfiber cloth. Once you’ve attacked the effective area, a clean microfiber cloth that’s been
moistened with distilled water should remove
any remaining residue.
AudioQuest CleanScreen Kit with Cleaning Fluid, Microfiber
Cloth, and Retractable
Brush - A purpose-built
cleaning solution for screens of all types
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If you’re not comfortable doing this, purposebuilt cleaning solutions exist like AudioQuest
CleanScreen that promise to safely clean display surfaces without damaging them. Of
course, there’s always a risk of damage
when using any product, though purposemade solutions are a lot safer than household cleaners and tap water.
Don’t Forget About the Back Too
LCD screens use LED backlights which can
kick out a fair bit of heat, while OLED displays also generate heat as a byproduct of
the chemical reaction that lights up individual
pixels. Plasmas and CRTs were also notorious for heat production, so cleaning the back
of a display is equally as important as cleaning the front.
Make sure you take the time to blow out any
dust from vents using canned air or use a
microfiber cloth to remove any material that
may hinder cooling. Take care not to use a
vacuum or similar since static electricity can
build up and cause damage to internal
components.
Clean Sparingly for Best Results
While you should take care to make sure
dust buildup at the back of the unit is kept to
a minimum, you’re better off cleaning the
front of the display as sparingly as possible
to avoid scratching glass or wearing down
panel coatings.
Tim Brookes is a technology writer with
more than a decade of experience. He's invested in the Apple ecosystem, with experience covering Macs, iPhones, and iPads for
publications like Zapier and MakeUseOf. ❖
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WINDOWS FREE PAINT APP
An Overview
By Jim Cerny
Forums Coordinator and Instructor
Sarasota Technology Users Group, FL
www.thestug.org
vp1 (at) thestug.org
The PAINT app or program comes free with
all editions of Windows. It comes with many
options for you to create your drawings or images and to modify others. I would encourage
you to explore Paint and put it on your desktop. You will find it very useful if you take the
time to try it! Here is a quick overview of what
Paint can do.
If you do not have an icon on your Windows
desktop for Paint, you can open the app anytime by clicking on the “Windows” icon on the
bottom-left on your screen. This will bring up
an alphabetical list of all your apps in the left
column. Scroll down. The scrollbar for this list
may be challenging to see or find – it is very
narrow at the top of the list, on the right edge
of the list (not the window, just the list column.)
If your mouse finds it, it should widen to a
standard scrollbar width that you can see and
use. Scroll down until you see “Windows Accessories” and click on the down arrowhead
just to the right to open the contents of this
folder. Next, you should see “Paint” and click
on it to open it. (Note this is NOT “Paint 3D”.)
You can find out everything about Paint by
asking Google and viewing some good videos
about using it. But here is a quick picture of its
features.
You can open almost any image (photo, drawing, clipart, etc.) in Paint by using the “File” tab/
menu. The file types that Paint can work with
are BMP, JPEG, GIF, PNG, and single-page
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TIFF formats. Now you are free to play with
that image any way you want. You can
draw on it, add text or shapes, crop the image, and much more. You can also SAVE
the image using the “Save as” option, and
you can save your image as a different file
type.
Have you a desire to be an artist? On the
“Home” tab/menu, you can use Paint to
draw and create your images. Select your
color or pick your color from a palette, pick
a drawing tool (pen, brush, marker, etc.),
the size or width of your line, and draw
away. There are many useful shapes as
well, such as ovals, boxes, arrows, and
more. You can even zoom in as close as
you wish to see and work with each tiny
pixel if you want. That is about as detailed
as you can get. Remember, zooming in or
out on an image does not change the image size; it just lets you view the image
closer or farther away. If you make a mistake, the “undo” arrow at the top will erase
the last thing you did.
You can “Resize” an image to save
memory size, rotate the image, erase
things in the image, or select some part of
the image for some action, such as copy or
delete. Yes, you can add text in a “box” or
right on the image.
Has Paint now
sparked some interest? Please use
Google to ask
about how to use
Paint and explore its many options. It is a
very fun tool, easy to use, and will boost
your creativity too! No actual paint, no canvas, and no mess! ❖
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LACS NOTICES
WELCOME ALL
Gavin Faught, LACS Treasurer
New Members (0)
Renewals (4)
Guy Clark
Clara Harris
Helena Karagozian
Hedy Zhang

HOW TO JOIN OUR MAIL LISTS
LACS members can join one, or both, of the
lists shown by putting just their name in the
message body of an e-mail to each of the
lists they wish to join from the e-mail address they wish LACS to use. It's highly
recommended to join both lists.
•

PC@LACS+subscribe (at) groups.io

•

LACSLIST@LACS+subscribe (at)
groups.io
PC is for official LACS business only.
LACSlist is for any other computer or technology – related messages and questions.
Email computer or technology-related
questions or comments to all members
on the LACSLIST to
lacslist (at) lacs.groups.io.
New members will receive one invitation to
join each list; they must respond promptly or
follow the above instructions.
If you have any problems or questions
about joining the lists, please contact
Stephanie Nordlinger: nordlacs(at)aol.com.

HYPERLINKS
Underlined text (blue in the colored editions) in User Friendly usually means it's a
hyperlink to a website. Click on the link to
see the reference.

FIX YOUR PC FOR FREE?
LACS Member and presenter,
Jim McKnight, has an open
offer to LACS members to diagnose, repair,
disinfect, or upgrade members' PC’s for free.
There are certain limitations to Jim’s offer, so
see the details by clicking the “Fix my PC for
Free?” link at
Non-members can wisely invest in a oneyear new regular LACS membership
($40.00), and Jim will fix your PC problem,
too. Contact Jim for specific considerations.
HOW TO CHANGE YOUR CONTACT
INFORMATION
Go to www.lacspc.org. Click on Member
Forms in the bar under the picture. Under
Membership Update, select Click Here to
select either the DOC or PDF form. Fill it out,
and email it with your changes to
or mail it to
LACS, 11664 National Blvd. #343,
Los Angeles, CA 90064-3802.
ATTENDING A ZOOM MEETING
LACS members should receive, via email, a
link, Meeting ID, and Passcode to attend the
LACS general meetings a couple of days before the meeting. Please let Leah Clark
know by the morning of the meeting if
you don't have it.
You can put an icon to the link on your desktop so it's handy at meeting time.
1. Right-click a blank spot on your desktop.
2. Select New from the drop-down menu.
3. Select Shortcut.
4. Type or copy and paste the link in the box
that says "Type the location of the item."
5. Click Next.
6. Type a name for the shortcut.
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LACS CALENDAR

LACS Board Meeting
Date: Monday, December 6, 2021 via Zoom
Time: 7:00 P.M. (Open from 6:30 P.M.)
Please arrive early so we can start on time.
Where: At your home or wherever you are

Holiday Lunch Party
Date: Saturday, December 11, 2021
Time: 1:00 P.M.
Where: Golden China Restaurant
9018 Venice Blvd, Culver City 90232

No General meeting in December
December 6: Last day of Hanukkah
December 21: Winter begins
December 25: Christmas
December 26: Kwanzaa
December 31: New Year's Eve

VISIT OTHER COMPUTER USER GROUPS
Check out the URL below for information for visiting other user groups' Zoom meetings and for
many more ideas for using Zoom and managing
dealing with the stay-at-home restrictions.
https://apcug2.org/tech-things-to-learn-whilesheltering-in-place/
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GENERAL MEETING
PRESENTATIONS VIA ZOOM
December 11, Saturday, 1:00 PM:
Holiday Lunch Party
There will be no general meeting on
December 14.
January 11: Tips for Using YouTube
This schedule is subject to Change.
Check your email and User Friendly for
updates.
ZOOM MEETINGS
To join a Zoom meeting, click on the
URL on the invitation you will receive
via email before the meeting and follow
the prompts.
Contact Leah Clark at
if you have any questions or if you
don't receive the link by the morning of
the meeting day.
Please enter before our meeting starting time in case problems need to be
solved and to ask questions. We want
our meetings to start on time.
ZOOM
RECORDINGS & PODCASTS
LACS members will receive links to
the recordings of Zoom meetings
via email.
To listen to the podcasts of most of
our past in-person general meetings,
go to https://www.lacspc.org/category/
audio-files/. Click on the session you
want to hear.
USER FRIENDLY BACK ISSUES
AND INDEXES
To see back issues of User Friendly, go to
http://www.lacspc.org/category/userfriendly/.
For indexes to past issues go to
https://www.lacspc.org/category/uf-index/
To find a specific article or topic, use the
search box on the top right.
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MEMBERS HELPING MEMBERS
LACS members volunteer to help other members solve hardware and software problems by
telephone during the hours listed below. Select the topic from the list and then contact a
person whose number is listed next to it. Find a helper's email address and phone number on your roster. If you don't have your roster, call 424-261-6251. Only members in good
standing may receive a roster. We hope that you find this LACS free service useful.
If you are experienced using a particular program or hardware, please volunteer to be
a consultant. You don't have to be an expert. To volunteer for this list or to make
corrections, please email Leah Clark at
or call her at 424-261-6251.
More Quick Consultants, and more categories are always needed. Do we have anyone who
can help with Google apps? You may decline or postpone a call if it comes at an inconvenient time.
Adobe Creative Suite: PDF,
InDesign, PhotoShop, etc. - 10
Android Smartphones - 8
Apple devices - 11
Anti Malware and Backup - 7, 8
Dragon Naturally Speaking - 3
Genealogy - 8
Groups.IO - 8
Hardware - 7

Lotus Word Pro, Approach - 7
Mozilla Firefox - 7
MS Excel - 8, 11, 12
MS Word - 1, 3, 8, 12
MS Outlook - 8, 1, 10
MS PowerPoint - 8, 11
MS Publisher - 2
Open Office - 6

Photoshop - 10
Quicken - 8, 12
Thunderbird - 7
Utilities - 7, 8
Visual Basic - 5
Websites - 5
Windows - 6, 7, 8
WordPerfect - 8
Zoom - 2, 9

Preferred Time for Phone Calls
Number

Name

From

To

1

Beckman, Loling

10:00 AM

6:00 PM

2

Clark, Leah

7:00 AM

5:00 PM

3

Hershman, Irv

11:00 AM

11:00 PM

5

Ialongo, Gilbert

9:00 AM

5:00 PM

6

Johnson, Carol

10:00 AM

9:00 PM

7

McKnight, Jim

8:00 AM

7:00 PM

8

Nordlinger, Stephanie

9:00 AM

5:00 PM

9

Presky, Mark

Any

Any

10

Rozek, E. J.

Noon

8:00 PM

11

Van Berkom, Paula

9:00 AM

5:00 PM

12

Wilder, Joan

9:00 AM

9:00 PM
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OFFICERS, DIRECTORS AND LEADERS
Title

Name

Term

President
Past President
Vice President
Secretary
Treasurer
Director
Director
Director
Director
Director
Director
Director
APCUG Rep.
Corporate Counsel
CCSC Computer Lab
Database Manager
Groups.IO Lists
Hospitality Chair
Newsletter Editor
Program Chair
Publicity – Press
Publicity – Online Media
Quick Consultants
Webmaster

Leah Clark
Stanley Johnson
Stephanie Nordlinger
Marcia Jacobs
Gavin Faught
Newton Bernstein
Irv Hershman
Paula Van Berkom
Sylvia Davis
Fred Kong
Howard Krivoy
Mark Presky
Leah Clark
Stephanie Nordlinger
Loling Beckman
Sylvia Davis
Stephanie Nordlinger
Sylvia Davis
Leah Clark
Stephanie Nordlinger
Mark Presky
Open
Leah Clark
Paula Van Berkom

2021
2021
2021
2021
2021
2021
2021
2021
2022
2022
2022
2022

Mailing Address: 11664 National Blvd., #343, Los Angeles, CA 90064-3802
Website: www.lacspc.org
Contact the President/Editor at 424-261-6251. Follow the prompts. This is a
Google Voice number.
Please use your roster for email addresses and phone numbers to contact any
officer, board member or other member, or you may leave a message at the above
number. If you don't have your roster, please contact Leah Clark at
and she will email you a copy. Only LACS members may receive a roster.
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COMPLETE ROBOCALL
DETERRENCE, PART 1 OF 3
A two-step approach:
Prevent the ring and convince the
robocaller that your line is disconnected
By John Krout
Presenter & Newsletter Contributor
Potomac Area Technology and Computer Society
https://www.patacs.org
jkrout.apcug.presenter (at) gmail.com

INTRODUCTION
Robocalls are a pervasive problem. The
Washington Post reported in April 2019 that
the estimated U.S. volume of robocalls in
March 2019 was 5.2 billion. That's a billion
with a B. Divide 5.2 billion by 31 days, then
24 hours, and then 3,600 seconds. So, the
number of robocalls per second was about
2,000.
Refusing to answer your smartphone is not
enough. Robocaller systems are smarter than
that; the systems won't stop calling. And the
robocalls often jam your voicemail inbox.
The best deterrence is based on a thorough
understanding of what automated robocall
systems do. Then, we can use robocall
system behaviors against the robocaller
systems.
•

First, robocaller systems change their
Caller IDs constantly. Often, when placing
1,000 calls, a robocaller system can use
as many as 1,000 different Caller IDs.
Since most robocall deterrence apps and
systems maintain a database of robocall
Caller IDs, called a Blacklist, such databases always fall behind the robocaller
Caller IDs.

•

Second, robocaller systems often are
based overseas, making it impossible for
the .U.S. government to establish criminal
jurisdiction.

•

Third, robocaller systems keep a list of
phone numbers known to have answered

December 2021

their robocalls in the past, even calls
"answered" by a voicemail greeting. The
robocall systems continue to call those
phone numbers ad nauseum.
SPOOFING
Robocall systems use a phone network behavior called spoofing to hide their real Caller IDs. That phone network behavior introduced many decades ago had, and it still
has, a valuable purpose for large phone subsystems such as companies, hospitals, and
the like.
Spoofing allows a caller to change the Caller
ID shown to you when the customer calls
you. The idea was to show the organization's main number, often the receptionist,
even if the call was placed from technical
support or Accounts Payable. This is appropriate for a large organization calling you
back so that you can see a consistent and
familiar Caller ID rather than one of the dozens or hundreds of phone lines used by the
organization. That Caller ID replacement is
done inside the phone network, based on
commands sent by the caller system.
The bad news is that the phone network
never imposed any security or restraints
on Caller ID replacement.
The key thing to know is that automated robocaller systems often use spoofing to
change their Caller IDs and with impunity.
Often robocall systems use a spoofed Caller
ID, including your area code and even your
exchange (the three digits after the area
code), to appear to be a call originating locally. The systems might even show a caller
ID for a live local phone number. The systems seldom use the same ten-digit number
twice to dodge Blacklist enforcement.
WHITELIST: AN ALTERNATIVE TO
BLACKLIST
In the area of robocall deterrence based on
Caller ID, the most powerful strategy for you
is Whitelist, meaning configuring your
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phone to accept incoming calls only from the
numbers in your phone's Contacts.
I have used that method on my phone since
roughly September 2019. Paul Brandus, a
Marketwatch.com columnist, had asked his
readers to send in their own personal fixes for
robocalls. Brandus published the most interesting reader responses in September 2019.
Brandus did not publish details of Whitelist
configuration but did provide enough info for
me to figure out the details on my own.
WHITELIST BEHAVIOR OUTLINE
The Settings feature you need to find in any
iPhone or Android phone is called Do not disturb. The Settings app may allow you to type
in a search term to find the place in the Settings app where you can access the feature.
Use Settings search to find Do not disturb.
The basic purpose of Do not disturb is, "Don't
ring the phone." It is not the same as Airplane
mode, which disconnects your phone from the
cell tower network. When Do not disturb is on,
the phone stays connected to the cell tower
network. You can place calls and read and
write emails and text messages while using Do
not disturb with Whitelist configuration.
And, very importantly, you can configure an
exception to Do not disturb. The exception I
have chosen are calls from my Contacts list.
That turns this configuration into a Whitelist behavior. Calls from my Contacts will ring my
phone. Other calls will not.
Once in a while, I have to turn off Do not disturb, for instance, if I expect a call from my
state's COVID vaccine management office. Of
course, I don't have any idea what that number
might be.
So, yet another feature of Do not disturb becomes very valuable. It is possible to configure
the phone to resume Do not disturb on a
schedule automatically. For example, I have
my phone set to continue Do not disturb at 10
PM local time. That way, I do not have to remember to re-enable Do not disturb after the
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expected call comes in. Unfortunately, the
scheduling system requires you to specify
a time range when Do not disturb will be in
effect.
The complete Android Whitelist configuration steps are captured from my Samsung
Galaxy S10 running Android 11 OS. Before
Android 11 was available, I was able to do
the same setup using Android 10, but the
step details differed in some minor ways.
STEP 1. Open the Settings app. Illustration 1 shows the main screen of the Settings app. Tap the Notifications choice,
which is circled in Illustration 1.
STEP2. The Notifications screen opens,
as shown in Illustration 2. In that screen,
find the Do not disturb choice, which is
circled in Illustration 2.

Illustration 1

Illustration 2
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STEP3. The Do not disturb screen opens,
as shown in Illustration 3. On that screen,
tap the phrase Add Schedule, which is circled in the illustration.
STEP 4. The Schedule screen opens, as
shown in Illustration 4. In that screen, make
sure all seven days of the week are selected.
STEP 5. Then tap the End Time, which
opens a time adjustment window, shown in
Illustration 5. Change that to 9:59 PM the
next day. Each of the three parts (hour, minute, and AM/PM) can be adjusted by swiping up and down.
At the lower right corner of the window, tap
the Done button. The window closes.

Illustration 3
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The Schedule screen closes, and the Do not
disturb screen reappears. The schedule name
and hours now appear under the Schedule
heading on the screen.
STEP 8. In the Do not disturb screen, tap
Calls, Messages, and Conversations under
the Exceptions heading, which is circled in Illustration 6. That tap opens the Calls, messages, and conversations screen, as shown
in Illustration 7.
STEP 9. In the Calls, messages, and conversations screen, tap the word Calls, which
is circled in Illustration 7. A menu appears, as
shown in Illustration 8.

Illustration 6
Illustration 4

Illustration 5

Illustration 7
Illustration 8

STEP 6. In the Schedule screen, in the Name
field above the weekday list, type a name
such as 24 hours.
STEP 7. At the bottom of the Schedule
screen, tap the Save button (not shown).

STEP 10. In the menu, tap the Contacts
Only choice. The menu closes, and the
phrase Contacts only appears below the word
Calls. At the top of the screen, tap the left
arrow to return to the Do not disturb screen.
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STEP 11. In the Do not disturb screen, tap
the Hide Notifications heading. The Hide notifications screen appears. Turn off all of the
switches on that screen. At the top of the
screen, tap the left arrow to return to the Do
not disturb screen.
STEP 12. In the Do not disturb screen, turn on
the Do not disturb switch. You can see that
switch in Illustration 3.
Note: that same Do not disturb switch can be
used to disable Do not disturb when you expect a legitimate incoming call from someone
outside of your Contacts list. Due to the automatic schedule, you won't have to turn on
Do not disturb manually; the phone will do it
for you.
That's it. Your Android phone is configured for
Whitelist behavior. Exit the Settings app.
IPHONE DO NOT DISTURB
I identified similar Whitelist settings on my corporate iPhone 6s. Due to corporate policy issues, I was unable to apply and test the iPhone Whitelist settings. The basics are very
similar to Android: in Settings, find Do not disturb. Set a schedule, set an exception for Contacts, and turn off Hide Notifications.
NEXT UP
In part 2 of this article series, you will learn
how to convince robocaller systems that your
phone number is not in service so they won't
call you again, and how to assemble a combination of your voice and other sounds in a
voicemail greeting for that purpose.
ABOUT THE AUTHOR: John Krout has been
writing about creative uses of personal computers since the early 1980s, and more recently, about creative uses of smartphones. He finished a long career as a software engineer
with 14 years as a technical writer for a federal
contractor. He lives in Arlington, Virginia, with
his son, many computers and cameras, and
too many cats. ❖
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CREATING AND USING MACROS
IN MS WORD 365
By Tom Burt, Vice-President
Sun City Summerlin Computer Club
https://www.scscc.club
t o m b u r t 8 9 1 3 ( a t ) c o x. n e t
This month we'll take a look
at macros, a little-used but
powerful feature of all the MS
Office programs. A macro is a
piece of program code that can be executed
whenever you want to operate on a section
of a document to perform a defined sequence of changes such as formatting or
editing. For example, macros can help insert
letterheads, generate pre-formatted tables,
applying fonts, highlighting, or styles. In addition, macros make it easy to carry out everyday repetitive actions as easily as clicking
a single button. For this article, we'll focus
on Word macros.
Creating and Saving Macros using the
Macro Recorder
The easiest way to create a macro in Word
is to turn on macro recording, perform a sequence of formatting and editing steps and
then stop recording. The recorded macro
can be given a name and have an optional
hot-key sequence or a "Quick Access" button assigned to it.
Here are the essential steps:
On the View tab of the Word ribbon, go to
Macros and click the down (v) widget to
open a menu; choose "Record Macro." That
will open a small Record Macro dialog. Give
the macro a name and optionally fill in the
description. You can also click to assign a
"Quick Access" button or a hot-key sequence to your macro. Finally, click OK and
begin the sequence of steps to be recorded.
When you are finished, go back to View >
Macros, click the down (v) widget, and
choose Stop Recording. Your newly recorded macro's name will now appear in the list
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of macros. You can go to this list, select your
macro and then click the Run button to run it.
More conveniently, if you assign the macro to
a Quick Access button, click the button to run
the associated macro.

Word Macro (Visual Basic) Editor
Let's look at my very simple macro's recorded
VBA statements. The green lines (They will
appear bolded in a black and white copy.)
preceded by apostrophes are code comments.
Sub TomDemo1()
' TomDemo1 Macro
' Convert a paragraph's text to Arial 12pt.
Selection.Font.Name = "Calibri"
Selection.Font.Size = 12
End Sub

Once a paragraph or sentence has been selected, clicking the Quick Access button to
run the macro changes the selection's font
name to Calibri and font size to 12 points.
Let's make this macro do a bit more work by
also setting the line spacing to 1.5 lines and
the text alignment to Justified. The macro
would then look like this:
Editing Macros Using the Macro Editor
Word generates a series of program statements in the Visual Basic for Applications
(VBA) language when recording a macro. A
Word document is organized into a hierarchical set of collections such as sections,
paragraphs, sentences, words. These elements can be accessed using VBA statements, and their various properties can be
changed. You can see the generated VBA
code by going to View > Macros > View Macros, selecting your macro, and clicking the
Edit button. This will open the VBA macro
editor with your macro displayed.

Sub TomDemo1()
' TomDemo1 Macro
' Convert a paragraph's text to Arial 12pt,
line spacing 1.5,
' alignment justified.
With Selection
.Font.Name = "Calibri"
.Font.Size = 12
.ParagraphFormat.LineSpacingRule =
wdLineSpace1pt5
.ParagraphFormat.Alignment = wdAlignParagraphJustify
End With
End Sub
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Note that I've also modified the macro to use
a VBA "With" clause to eliminate the need to
explicitly specify "Selection." for each property
reference. This makes the macro code easier
to read and run faster, and it also simplifies
making changes. The "wd" symbols to the right
of the = signs are Word internal symbolic
constants.
The macro editor is helpful by automatically
offering a menu of "Intellisense" choices. Thus,
you don't have to remember or learn every
possible property of every object or collection.
Example Macro – Formatting an Article for
the Gigabyte Gazette
Now let's look at a more real-world situation.
Every month, when I edit the Computer Club's
Gigabyte Gazette newsletter, I need to integrate articles and other content from various
sources and give them a standard format. One
way I simplify this is by using predefined Word
styles. I have five: Heading 1, Heading 2,
Heading 3, Heading 4, and GGBody.
Here's the VBA code of a macro named
GGFormat that applies the GGBody style to
each paragraph in a selected area of a document, except those that already have a
"Heading x" style.
Sub GGFormat()
' GGFormat Macro - Convert all non-Heading
paragraph Styles to "GGBody"
Dim pg As Word.Paragraph
With Selection
' Iterate the document's collection of Paragraph objects
For Each pg In.Paragraphs
' Only change non-Heading paragraphs
If Left(pg.Style, 7) <> "Heading" Then
pg.Style = "GGBody"
End If
Next
End With
End Sub
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The "For Each" statement loops through the
Selection's collection of paragraph objects,
successively referencing each via the pg
variable. Each paragraph's Style property is
checked to see if it begins with "Heading." If
not, the paragraph's Style property is
changed to "GGBody."
Now I can open one of my submitter's documents and copy its contents to the desired
place in my working copy of this month's Gigabyte Gazette newsletter. Then I select all
the body text of the copied article, go to
View > Macros > View Macros, and run my
GGFormat macro. This formats all the body
text to have Style = GGBody but leaves the
rest of the document alone.
A Caution
Macros are very powerful and can sometimes affect places in your document that
you did not intend. For example, I had a test
document open while experimenting, but I
also had this document (the May Gigabyte
Gazette) open. My GGFormat macro above
initially operated on the entire active document rather than the current selection. I expected it just to format my test document,
but it formatted both documents – NOT what
I wanted when I ran it. So, I modified the
GGFormat macro to only operate on the current Selection.
Learn More
We've barely broken the surface of what can
be done with macros in MS Word. Here are
some hyperlinks to more in-depth information on Word macros:
https://support.microsoft.com/en-us/office/create-orrun-a-macro-c6b99036-905c-49a6-818adfb98b7c3c9c
https://www.pcworld.com/article/2952126/wordmacros-three-examples-to-automate-yourdocuments.html
https://www.ionos.com/digitalguide/online-marketing/
online-sales/creating-macros-in-word/
https://word.tips.net/C0012_VBA_Examples.html ❖
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JERE’S TECH TIPS
For many helpful tips and tricks for all aspects of computing, see Jere’s Tech Tips at
https://apcug2.org/jerestips/.
TECHBOOMERS.COM
teaches how to use various websites and
internet-based applications.
•

https://TechBoomers.com

•

https://www.youtube.com/watch?v=O2bwYIYu1I
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LAUGHING OUT LOUD
A New GPS
The other day I bought a new GPS for
old angry people...
It tells other people where to go!

SPECIAL OFFERS
Go to the APCUG website https://
apcug2.org/discounts-special-offers-foruser-groups/ for discounts and special offers for Members of User Groups. Avast Anti-virus and Acronis True Image, and several book, media and training sites offer discounts including the two mentioned below.
•

•

Members can save at the
Pearson Technology websites:
InformIT, Cisco Press, Pearson IT Certification, Que Publishing, Adobe Press,
and Peachpit Press.
Informit.com/user_groups/index.aspx
Code for print books: ITCOMMUNITY
Code for eBooks:
DIGITALCOMMUNITY
See the latest books on digital imaging
and photography, gaming, animation,
film and video, post-production, audio,
music technology, broadcast and theatre
from Routledge | Focal Press today!
They offer discounts to User Group
members.
NOTICE

The columns, reviews and other expressions of
opinion in User Friendly are the opinions of the writers and not necessarily those of the Los Angeles
Computer Society. LACS became a California nonprofit corporation on July 17, 1991. Its predecessor
was the UCLA PC Users Group.

"I forgot to program my smartwatch
to remind me to stop running. I'm
about 1,200 miles away."
From How-To Geek
Dear Santa, I'm asking for a Big Fat
Bank Account and a Slim Body.
Please do not mix these up like you
did last year.
COPYRIGHT © 2021

by the Los Angeles Computer Society, an allvolunteer, tax-exempt [IRC Section 501(c)(3)] nonprofit California corporation. All rights reserved. User
Friendly is published monthly. Subscriptions are
included in membership dues. Reproduction of any
material here by any means is expressly prohibited
without written permission, except that other nonprofit User Groups may reprint LACS articles in substantially unaltered form if credit is given to the author and this publication and an e-mail is sent to us
via our website, www.lacspc.org, reporting the reprint information (user group and the name and date
of the publication). Product and company names are
the trademarks of their respective owners.
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Annual Membership Dues:
Regular New and Renewal,
Printed Newsletter
$ 40
Electronic Newsletter 30
Family-Associate
12
Students
18
Contributor
50
Supporter
75
Benefactor
100
Gift Membership
20
A subscription to User Friendly
is included with membership.
Associate members live in
the same household or work at
the same address as a regular
member; they do not receive
their own subscriptions to User
Friendly, but may read it on
the LACS website. Students
must prove full-time status. A
member may give a 1-year, 1time gift to a non-member.


Date: __________
Check # ________
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MEMBERSHIP INFORMATION
Monthly general meetings
— Free APCUG (International
are via Zoom. In-person or
Association of Technology and
hybrid meetings may take
Computer User Groups) Webinars.
place in the future.
— Free quarterly Virtual
Members also enjoy these
Technology Conference (VTCs)
special benefits:
— Information on training
— Monthly Newsletter
and technical education.
User Friendly. We publish your
— Occasional free software and
article submissions or free
computer books, if you review
classified ads to buy or sell your
them for User Friendly.
computer items.
— Rewards for recruiting; LACS
— Get FREE help by phone
will extend your membership for
from knowledgeable members
three months for each new regular
who are Quick Consultants
listed in User Friendly.
member you recruit.
— Get help by email by
— Annual Holiday Party
using our LACSLIST Group
— Social Interacting with others
eMail List. Send your questions
who have like interests in computers
to lacslist (at) lacs.groups.io
— Receive important news and technology.
— Special Interest Groups
and announcements via User
(SIGs) on various topics may be
Friendly and LACS’s Group
e-mail lists.
created by members.

LACS





New or Renewal Membership Application

Please mail your dues and this form to:
Los Angeles Computer Society, 11664 NATIONAL BLVD. #343, LOS ANGELES CA 90064-3802

Please PRINT Clearly
[

[ ] New
[ ] Renewal
] New / Renewal with printed newsletter - $40.00
[ ] Associate - $12.00

[

] New / Renewal with electronic, no paper, newsletter - $30.00

[

] Contributor - $50.00

[

] Supporter- $75.00

[

[

Last

Name of Associate: First

Last

] Student - $18.00

] Gift Membership - $20.00

] Benefactor - $100.00

Name: First

[

[

] Other

(Same address as primary member)
___________________________________________________________________________________________________________

Address:
________________________________________________________________________________________
City, State, Zip + 4
_________________________________________________________________________________________________

E-mail Address:

E-mail of Associate

_________________________________________________________________________________________________

Preferred Phone:

Publish Contact Info in Roster [

] Yes

[

] No

Did a member of LACS invite you to join? If so, who? If not, how did you hear about LACS?
Revised Dec. 2020, ljc

Editor…..…………........... Leah Clark
Indexer ……….….............Leah Clark
Podcast Transcriber ... . Irv Hershman
Photographer…….................. Vacant
Proofreaders …...........Irv Hershman,
Jim McKnight, and
Stephanie Nordlinger
FREE!
Earn 3 months of free
membership for every new regular
member you bring in.

User Friendly is published by the Los Angeles Computer Society.
11664 NATIONAL BLVD, #343 LOS ANGELES CA 90064-3802
Voice-mail: 310-780-3302. Web site: http://www.lacspc.org

GENERAL MEETINGS WILL BE ON ZOOM UNTIL FURTHER NOTICE.

Before each meeting, members and invited guests will receive an
email with the URL link to the meeting. If you haven’t received it by
the morning of the meeting, let Leah Clark know. When you click on
the link, you will enter a waiting room. Then the host or a co-host will
admit you to the meeting.
Please try to arrive at least a few minutes before the meeting starttime so you don't interrupt the meeting and any problems can be
solved. If you need to take a break during a meeting, do not click on
Leave or End. If you do, the meeting will be interrupted for someone
to re-admit you from the waiting room. You may turn off your video
when you are gone.

